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QUESTION 1

You work as a Sales Manager for Maini Industries. Your company manufactures and sells 

construction equipment. You have to create a report that will show the highest selling items of 

each month. The report will be in the following format: 

In a workbook, you create a table named Item_table as shown below: 

You fill in the required entries in the workbook. 
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For the third column of the sheet, you want to use formulas to fill in the values. You want the 

cells in the third column to get automatically filled with the names corresponding to ItemID in the second column. You
want the exact values to be filled in the column. You select the C2 cell in the third column. 

Which of the following formulas will you enter in order to accomplish the task? 

A. =VLOOKUP(B2,Item_table,2,FALSE) 

B. =VLOOKUP(B2,Item_table,2,TRUE) 

C. =VLOOKUP(2,Item_table,B2,FALSE) 

D. =VLOOKUP(2,Item_table,B2,TRUE) 

Correct Answer: A 

In order to accomplish the task, you will use the following formula: 

=VLOOKUP(B2,Item_table,2,FALSE) 

Answer option B is incorrect. According to the question, you want the exact values in the column. 

The TRUE value in the range_lookup argument provides the approximate match. Answer options C and D are incorrect.
The VLOOKUP functions used in the formulas have wrong syntaxes. 

 

QUESTION 2

You work as an Office Assistant for Tech Perfect Inc. The company has a Windows-based network. You are creating a
business report by using. Microsoft Excel 2013. You have arranged sales data as shown below: 
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You want to provide pictorial representation of the trend of the sales data in front of each row. 

Which of the following actions will you take to accomplish the task with the least amount of administrative burden? 

A. Use stand-alone slicers. 

B. Configure form controls. 

C. Create sparklines. 

D. Create a PivotTable report. 

Correct Answer: C 

 

In order to accomplish the task with the least amount of administrative burden, use sparklines. 

Sparklines, introduced in Microsoft Office 2013, are tiny charts that can fit in a cell. The sparklines can be used to show
trends in a small amount of space. The sparklines visually summarize trends alongside data. 

The sparklines can be added through the Insert tab. Answer option A is incorrect. Stand-alone slicers are referenced
from Online Analytical Processing (OLAP) Cube functions. These stand-alone slicers can be connected with any
PivotTable 

in future. 

They can be added by using the slicer button on the Ribbon. They need to be manually linked into grids as required. 

Answer option B is incorrect. A form control is an original control that is compatible with old versions of Excel, beginning
with Excel version 5. 0. It is designed for use on XLM macro sheets. It can be used when a user wants to simply
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interact 

with cell data without using VBA code and when he wants to add controls to chart sheets. By using form controls, the
user can run macros. He can attach an existing macro to a control, or write or record a new macro. These controls
cannot 

be added to UserForms, used to control events, or modified to run Web scripts on Web pages. 

Answer option D is incorrect. A PivotTable report is used to summarize large amounts of data, to analyze numerical
data, and to answer unexpected questions about data. 

 

QUESTION 3

You work as an Office Assistant for Media Perfect Inc. You have created a spreadsheet in Excel 2013 and shared it with
the other employees of the company. You select the Encrypt with Password option as a protection measure for the
document you are sharing. Now, you have to specify a password in the Password box in the Encrypt Document dialog
box appeared for editing the document. But you have forgotten the password. What will happen in this situation? 

A. You will use a new password. 

B. You will ask Microsoft to retrieve the password. 

C. You will fetch the password from the list in which you have saved it. 

D. You will create a new document. 

Correct Answer: C 

The various Protect Workbook options are as follows: 

1.

 Mark as Final: This option is used to make the document read-only. When a spreadsheet is marked as final, various
options such as typing, editing commands, and proofing marks are disabled or turned off and the spreadsheet becomes 

read-only. This command helps a user to communicate that he is sharing a completed version of a spreadsheet. This
command also prevents reviewers or readers from making inadvertent modifications to the spreadsheet. 

2.

 Encrypt with Password: When a user selects the Encrypt with Password option, the Encrypt Document dialog box
appears. In the Password box, it is required to specify a password. Microsoft is not able to retrieve lost or forgotten 

passwords, so it is necessary for a user to keep a list of passwords and corresponding file names in a safe place. 

3.

 Protect Current Sheet: This option is used to select password protection and permit or prohibit other users to select,
format, insert, delete, sort, or edit areas of the spreadsheet. This option 

protects the worksheet and locked cells. 

4.

 Protect Workbook Structure: This option is used to select password protection and select options to prevent users from

Latest 77-427 Dumps | 77-427 PDF Dumps | 77-427 VCE Dumps                              5 / 15

https://www.leads4pass.com/77-427.html
https://www.leads4pass.com/77-427.html
https://www.leads4pass.com/77-427.html


https://www.leads4pass.com/77-427.html
2024 Latest leads4pass 77-427 PDF and VCE dumps Download

changing, moving, and deleting important data. This feature enables a user to protect the structure of the worksheet. 

5.

 Restrict Permission by People: This option works on the basis of Window Rights Management to restrict permissions. A
user is required to use a Windows Live ID or a Microsoft Windows account to restrict permissions. These permissions 

can be applied via a template that is used by the organization in which the user is working. These permissions can also
be added by clicking 

Restrict Access. 

6.

 Add a Digital Signature: This option is used to add a visible or invisible digital signature. 

It authenticates digital information such as documents, e-mail messages, and macros by using computer cryptography.
These signatures are created by specifying a signature or by using an image of a signature for establishing authenticity, 

integrity, and non-repudiation. 

Answer option D is incorrect. You can create a new document with the same details but it will increase the overhead
and is a very time consuming process. Answer option D is incorrect. You can create a new document with the same
details but it will increase the overhead and is a very time consuming process. 
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QUESTION 4

Rick works as an Office Assistant for Tech Perfect Inc. The company has a Windows- based network. 

Rick is creating a project through Microsoft Excel 2013. The project on which he is working has 98 project tasks and 57
team members. Rick wants to check the progress of his project quickly and easily. Which of the following will Rick use to
accomplish the task? 

A. Gantt Chart Template 

B. Form control 

C. Trust Center 

D. Accounting template 

Correct Answer: A 

The Gantt Chart Template Deluxe Edition for Excel is used to generate quick and easy Gantt charts that define the
progress of a user\\'s projects containing up to 100 project tasks and team members. Answer option B is incorrect. A
form control is an original control that is compatible with old versions of Excel, beginning with Excel version 5. 0. It is
designed for use on XLM macro sheets. It can be used when a user wants to simply interact with cell data without using
VBA code and when he wants to add controls to chart sheets. By using form controls, the user can run macros. He can
attach an existing macro to a control, or write or record a new macro. These controls cannot be added to UserForms,
used to control events, or modified to run Web scripts on Web pages. Answer option D is incorrect. The accounting
template is used for numbering months of a financial year to period numbering. It is used to compare month to month,
actual v budget, quarter to quarter, year to year variances. It is the initial point for other reports that need the use of
months. Answer option C is incorrect. Trust Center is where a user can find security and privacy settings for Microsoft
Office 2013 programs. 

 

QUESTION 5

Which of the following steps will you take to merge copies of a shared workbook? Each correct answer represents a part
of the solution. Choose all that apply. 

A. In the Select Files to Merge into Current Workbook dialog box, click a copy of the workbook containing changes to be
merged, and then click OK. 

B. Click Compare and Merge Workbooks on Quick Access Toolbar. 

C. Open the copy of the shared workbook to merge the changes. 

D. Save the workbook if prompted. 

E. Add Compare and Merge Workbooks. 

F. Click Compare and Merge Workbooks on Macro Enabled Access Toolbar. 

Correct Answer: ABCDE 

Take the following steps to merge copies of a shared workbook: 

1.

 Add Compare and Merge Workbooks. 
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2.

 Open the copy of the shared workbook to merge the changes. 

3.

 Click Compare and Merge Workbooks on Quick Access Toolbar. 

4.

 Save the workbook if prompted. 

5.

 In the Select Files to Merge into Current Workbook dialog box, click a copy of the workbook containing changes to be
merged, and then click OK. 

 

QUESTION 6

You work as an Office Manager for Blue Well Inc. The company has a Windows-based network. You want to change
values in cells to observe the way in which those changes are affecting the outcome of formulas in the worksheet.
Which of the following will you use to accomplish the task? 

A. Form control 

B. Trust Center 

C. Accounting template 

D. What-if analysis 

Correct Answer: D 

What-if analysis is defined as the process of changing values in cells to observe the way in which those changes are
affecting the outcome of formulas in the worksheet. There are three types of what-if analysis tools that are named as
scenarios, data tables, and Goal Seek. A user can also install the Solver add-in to accommodate more variables than
Goal Seek. Answer option A is incorrect. A form control is an original control that is compatible with old versions of
Excel, beginning with Excel version 5. 0. It is designed for use on XLM macro sheets. It can be used when a user wants
to simply interact with cell data without using VBA code and when he wants to add controls to chart sheets. By using
form controls, the user can run macros. He can attach an existing macro to a control, or write or record a new macro.
These controls cannot be added to UserForms, used to control events, or modified to run Web scripts on Web pages.
Answer option C is incorrect. The accounting template is used for numbering months of a financial year to period
numbering. It is used to compare month to month, actual v budget, quarter to quarter, year to year variances. It is the
initial point for other reports that need the use of months. Answer option B is incorrect. Trust Center is where a user can
find security and privacy settings for Microsoft Office 2013 programs. 

 

QUESTION 7

You work as an Office Manager for Blue Well Inc. The company has a Windows-based network. You have a formula
that uses one or two variables or multiple formulas that all use one common variable. You want to examine a range of
possibilities at a glance. Which of the following will you use to accomplish the task? 

A. Goal Seek 
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B. Solver add-in 

C. Data table 

D. Scenario 

Correct Answer: C 

A data table is used to see all the outcomes in one place. It is defined as a type of what-if analysis tools. It is used if a
user has a formula that uses one or two variables or multiple formulas that all use one common variable. It is used to
examine a range of possibilities at a glance and since the user focuses on only one or two variables, results are easy to
read and share in tabular form. If automatic recalculation is enabled, it is possible to recalculate the data in data tables
immediately and as a result, the user always gets fresh data. Answer option D is incorrect. A scenario is defined as a
type of what-if analysis tools. It is a set of values saved by Excel and can be substituted automatically in cells on a
worksheet. A user can create and save different groups of values on a worksheet and then switch to any of these new
scenarios to view different results. Scenario reports are not automatically recalculated. If the user changes the values of
a scenario, those changes will not be displayed in an existing summary report and he must create a new summary
report to show the reflection of the changed report. Answer option A is incorrect. Goal Seek is defined as a type of what-
if analysis tools. It is used if a user knows the result that he wants from a formula, but he is not sure what input value the
formula needs to get that result. It works with only one variable input value. Answer option B is incorrect. The Solver add-
in is used if a user knows the result that he wants from a formula, but he is not sure what input value the formula needs
to get that result. It is used for more than one input value. It works with a group of cells related to the formula in the
objective cell. 

 

QUESTION 8

You work as an Office Assistant for Tech Perfect Inc. You are working in the spreadsheet of the company\\'s high selling
products. You want to find out the matching values. You get an unexpected error that when you attempt to look up or 

match a lookup_value within an array, Excel is not able to recognize the matching value. Which of the following steps
will you take to resolve the problem? Each correct answer represents a part of the solution. 

Choose all that apply. 

A. Remove the unseen spaces at the start or end of the first Macro cell. 

B. Delete the column having the TRIM function. 

C. Copy the contents of the new column and paste them on the top of the original column by using paste > special >
values sequence. 

D. Create a new column subsequent to the one with the additional spaces in it. 

E. Use the TRIM function in the new column. 

Correct Answer: BCDE 

In this situation, you will take the following steps: 

1.

 Create a new column subsequent to the one with the additional spaces in it. 

2.
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 Use the TRIM function in the new column to get rid of extra spaces. 

3.

 Copy the contents of the new column and paste them on the top of the original column by using paste > special >
values sequence. 

4.

 Delete the column having the TRIM function. Answer option A is incorrect. This is an invalid answer option. 

 

QUESTION 9

You work as an Office Assistant for Blue Well Inc. The company has a Windows-based network. You want to quickly
filter data in a PivotTable report without opening drop-down lists to find the items that you want to filter. For this purpose,
you are required to use a slicer. Which of the following are the ways that you can use to accomplish the task? Each
correct answer represents a complete solution. Choose all that apply. 

A. Create a copy of a slicer connected with the PivotTable. 

B. Create a slicer connected with the PivotTable. 

C. Create a slicer by disabling Macros associated with the PivotTable. 

D. Use an existing slicer connected with another PivotTable. 

Correct Answer: ABD 

The various ways to use or create slicers to filter PivotTable data in an existing PivotTable are as follows: 

1.

 Create a slicer connected with the PivotTable. 

2.

 Create a copy of a slicer connected with the PivotTable. 

3.

 Use an existing slicer connected with another PivotTable. 

Answer option C is incorrect. This is an invalid answer option. 

 

QUESTION 10

You work as an Office Assistant for Tech Perfect Inc. You are working in the spreadsheet of the company\\'s high selling
products. You want to find out the matching values in the columns. While doing so, you get an unexpected error that
when you attempt to look up or match a lookup_value within an array; Excel is not able to recognize the matching value.
You want to store sets of values as text and convert sets of data to text by using Excel\\'s Text To Columns tool. Which
of the following steps will you take to accomplish the task? 

Each correct answer represents a part of the solution. Choose all that apply. 
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A. Select the Text to Columns option from the Data tab at the top of the Excel workbook. 

B. Select Text and click the Finish button in Column Data Formats. 

C. Select the Delimited option and click Next 

D. Make sure that all delimiter options are unselected, and then again click Next. 

E. Remove the unseen spaces at the start or end of the first Macro cell. 

F. Select the cells to convert their data to text. 

Correct Answer: ABCDF 

In this situation, you will take the following steps: 

1.

 Select the cells to convert their data to text. 

2.

 Select the Text to Columns option from the Data tab at the top of your Excel workbook. 

3.

 Select the Delimited option and click Next. 

4.

 Make sure that all delimiter options are unselected, and then again click Next. 

5.

 Select Text and click the Finish button in Column Data Formats. 

 

QUESTION 11

You work as an Office Assistant for Tech Perfect Inc. You are working in a spreadsheet. You observe that while trying to
look up or match a lookup_value within an array, Excel is not able to recognize the matching value. Which of the
following are the reasons that are causing the above problem? 

Each correct answer represents a complete solution. Choose all that apply. 

A. The lookup_value or the array you are searching resides in a cell containing unseen spaces at the start or end of that
cell. 

B. The contents of the cells that are being compared may have different data types. 

C. Excel is trying to reference an invalid cell. 

D. You are inserting a new column, next to a column that is already formatted as text. 

Correct Answer: AB 
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The Failure to Look Up Values in Excel error occurs when a user gets an unexpected error while trying to look up or
match a lookup_value within an array and Excel is not able to recognize the matching value. If the lookup_value or the
array the user is searching resides in a cell, the user can have unseen spaces at the start or end of that cell. This will
create the situation where the contents of the two cells that the user is comparing look the same but extra spaces in one
of the cells cause the cells to have slightly different content. The other reason is that the contents of the cells that are
being compared may have different data types. Answer option C is incorrect. The Lookup Function Won\\'t Copy Down
to Other Rows error occurs when a user uses a function in one cell and it works perfectly but when he attempts to copy
the function down to other rows, he gets the #REF error. The #REF! error arises when Excel tries to reference an invalid
cell. This error occurs if the user has referenced an entire worksheet by clicking on the grey square at the top left of the
worksheet. For Excel, this reference range is 1 to 1048576. Since the references are Relative References, Excel
automatically increases the row references when this cell is copied down to other rows in the spreadsheet. Answer
option D is incorrect. The Excel Won\\'t Calculate My Function error occurs when a user types in a function and presses
Enter, the cell shows the function as the user typed it, instead of returning the function\\'s value. The reason that causes
this problem is that the cells containing the formula are formatted as \\'text\\' instead of the \\'General\\' type. This
happens when the user inserts a new column, next to a column that is already formatted as text due to which the new
column inherits the formatting of the adjacent column. 

 

QUESTION 12

Rick works as an Office Assistant for Tech Perfect Inc. He is creating a report through Microsoft Excel 2013. He wants
to fill the active cell with the content of the adjacent cell. Mark the option that he will choose to accomplish the task. 

Hot Area: 

Correct Answer: 
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QUESTION 13

Which of the following can be defined as easy-to-use filtering components containing a set of buttons that enable users
to quickly filter data in a PivotTable report, without opening drop-down lists to find the items to filter? 

A. Accounting templates 

B. ActiveX controls 

C. Form controls 

D. Slicers 

Correct Answer: D 

Slicers are defined as easy-to-use filtering components containing a set of buttons that enable users to quickly filter data
in a PivotTable report, without opening drop-down lists to find the items to filter. 

When a user uses a regular PivotTable report filter to filter on multiple items, the filter indicates only that multiple items
are filtered and the user has to open a drop-down list to find the filtering details. However, a slicer clearly labels the filter 

that is applied and provides details so that the data displayed in the filtered PivotTable report can be easily understood. 

Answer option B is incorrect. ActiveX controls are used on worksheet forms, with or without the use of VBA code, and
on VBA UserForms. 

They are used when a user needs more flexible design requirements than those provided by Form controls. They have
extensive properties that can be used to customize their appearance, behavior, fonts, and other characteristics. The
user 

can control different events that occur when an ActiveX control is interacted with. He can also write macros that respond
to events associated with the ActiveX controls. When a user interacts with the control, the VBA code runs to process
any 

events that occur for that control. The ActiveX controls cannot be added to chart sheets from the user interface or to
XLM macro sheets. It is not possible to assign a macro to run directly from the ActiveX control. Answer option C is
incorrect. 

A form control is an original control that is compatible with old versions of Excel, beginning with Excel version 5. 0. It is
designed for use on XLM macro sheets. It can be used when a user wants to simply interact with cell data without using 

VBA code and when he wants to add controls to chart sheets. By using form controls, the user can run macros. He can
attach an existing macro to a control, or write or record a new macro. These controls cannot be added to UserForms, 
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used to control events, or modified to run Web scripts on Web pages. 

Answer option A is incorrect. The accounting template is used for numbering months of a financial year to period
numbering. It is used to compare month to month, actual v budget, quarter to quarter, year to year variances. It is the
initial point 

for other reports that need the use of months. 

 

QUESTION 14

Which of the following is used to display a trend based on adjacent data in a clear and compact 

graphical representation by taking up a small amount of space? 

A. Trendline 

B. Line chart 

C. Sparkline 

D. Backstage view 

Correct Answer: C 

A sparkline is defined as a tiny chart in the background of a cell. Unlike charts on an Excel Worksheet, sparklines are
not objects. It is used because data presented in a row or column is useful, but patterns can be hard to spot at a glance.
It is used to display a trend based on adjacent data in a clear and compact graphical representation by taking up a small
amount of space. The benefit of using the sparklines is that these can be printed when a user prints a worksheet that
contains them. This feature is not available in charts. Answer option D is incorrect. The Microsoft Office Backstage view
is used to replace the traditional file menu with a new approach that uses In and Out features for efficiency. The
improved Ribbon enables users to access their preferred commands rapidly and create custom tabs to personalize the
way they work. Answer option A is incorrect. A trendline is defined in Excel 2013. It is a data visualization tool to display
the trend of a particular data range. It is used to show the slope of data points in a chart. There are various types of
trendlines, such as linear trendlines, exponential trendlines, and linear forecast trendlines. Answer option B is incorrect.
Excel provides a column chart facility to display data that is arranged in columns or rows on a worksheet. Line charts
are used to display continuous data over time, set against a common scale. In a line chart, category data is distributed
along the horizontal axis, and all value data is distributed along the vertical axis. Line charts are ideal for showing trends
in data at equal intervals. 

A line chart should be used where category labels are text, and are representing evenly spaced Values such as months,
quarters, or years. 
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QUESTION 15

You work as an Office Assistant for Tech Tree Inc. You have created a report in a workbook in Microsoft Excel 2013.
You want to summarize a large amount of data to analyze numerical data and to answer unexpected questions about
your data in the Business Intelligence (BI) report that you are working with. For this purpose, you are required to create
a PivotTable. Which of the following steps will you take to accomplish the task? 

Each correct answer represents a part of the solution. Choose all that apply. 

A. Click OK. 

B. Choose Select a table or range under Choose the data that you want to analyze. 

C. Select the Macro-enabled checkbox in the Insert Security dialog box, and then click OK. 

D. Click PivotTable or click the arrow below PivotTable, and then click PivotTable in the Tables group on the Insert tab. 

E. Click a cell in the cell range that contains data for using worksheet data as the data source. 

Correct Answer: ABDE 
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